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Introduction
Inventory Kardex is a tool that allows you to print reports that summarize 
information about your company’s inventory transactions. You can track the 
movements of the inventories and the costs of the goods in the warehouses. These 
costs are calculated using the Ongoing Average, Ongoing LIFO and Ongoing FIFO 
methods using the Unit of Measurement that is defined for the item.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Inventory Kardex, and how it integrates with the Microsoft Dynamics 
GP system.

To make best use of Inventory Kardex, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Inventory Kardex setup,” describes how to install Inventory Kardex 
for your company. You can also rebuild Kardex to transfer the transaction 
details from the Inventory module in Microsoft Dynamics GP to the Kardex 
module.

• Chapter 2, “Inquiries and reports,” explains how to view the transactions in 
Inventory Kardex and generate the reports.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites 
tab. Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the 
current window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Inventory Kardex setup
Use this information to update the Kardex with the details of inventory transactions 
posted in Microsoft Dynamics GP. You must perform this process when you first 
install Kardex for a company.

This information is divided into the following sections:

• Running the reconciliation process
• Building Kardex

Running the reconciliation process

You must run the reconciliation process for your sales, purchasing, and inventory 
balances to ensure that the quantities reported match the actual quantities on hand. 
You must run the reconciliation process before you rebuild Kardex as explained in 
Building Kardex on page 5. We recommend that you run the reconciliation in the 
order given below:

• Reconcile - Remove Sales Documents window (Microsoft Dynamics GP 
menu >> Tools >> Utilities >> Sales >> Reconcile - Remove Sales Documents)

• Reconcile Inventory Quantities window (Microsoft Dynamics GP 
menu >>Tools >> Utilities >> Inventory >> Reconcile)

• Reconcile Purchasing Documents window (Microsoft Dynamics GP menu >> 
Tools >> Utilities >> Purchasing >> Reconcile Purchasing Documents)

Refer to the Sales Order Processing, Inventory Control and Purchase Order 
Processing documentation for more information.

Building Kardex

You must run the Rebuild process in the Kardex Reconstruction window when you 
first install Kardex for a company. This process updates the Kardex module with the 
inventory transactions that you have previously posted in Microsoft Dynamics GP. 
Use the information given in Running the reconciliation process on page 5 to reconcile 
your books before performing the rebuilding process.

Be sure to back up your database before running the Kardex Reconstruction process.

To build Kardex:
1. Open the Kardex Reconstruction window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Inventory >> 
Kardex >> Choose Rebuild)
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2. In the Item group, select to include all the items set up in the Inventory module 
or select a range in the From and To fields respectively.

3. Choose Rebuild to reconstruct the Kardex details.

4. Choose End to complete the reconstruction process. A report will print detailing 
any adjustments in quantities.
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Chapter 2: Inquiries and reports
Use this information to view the details of inventory movement based on posted 
transactions. You can view the inventory movements for a single site or for all the 
sites that you have set up. You can also generate the Kardex reports for your 
company.

Inventory Kardex reports are available in the report list. You can select a report in 
the report list and add it to My Reports for easy access. Refer to the Microsoft 
Dynamics GP documentation for more information.

This information is divided into the following sections:

• Viewing inventory transaction information
• Creating a report option
• Printing Kardex reports

Viewing inventory transaction information

Use the Kardex Query window to view the Kardex for transactions that affect the 
stock quantity of an inventoried item.

You can view the transactions posted for an item only if you have selected to 
maintain transaction history for the item. To do this, you must mark the Transaction 
checkbox in the Maintain History field of the Item Maintenance Options window 
(Cards >> Inventory >> Item >> Options).

To view the inventory transaction information:
1. Open the Kardex Query window.

(Inquiry >> Inventory >> Kardex)

2. Enter or select an item number. The Description field displays the description 
for the selected item. The Evaluation Method and the U of M fields display the 
values you set up in the Item Maintenance window.
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3. In the Date group, select All to view details for all the transactions or enter a 
date range for which to view transaction details.

4. In the Site ID group, select All to view the transaction details for all sites or 
select a site.

5. Choose Redisplay to refresh the information in the window. The scrolling 
window displays the transaction details for the selected item based on the date 
range and site selected. You can select a line in the scrolling window and click 
the Document link to view the transaction details for the selected item.

The Total Entries field displays the total quantity and value of the selected 
items that were purchased or transferred to a site. The Total Outflows field 
displays the total quantity and value of the selected items that were sold or 
transferred from a site. The Total Inventory Balance field displays the quantity 
in stock and value of the selected items

6. Choose Inventory Quantities to open the Item Quantities Maintenance window 
where you can view and update information about the quantities of a specific 
item at a specific site. Refer to the Inventory Control documentation for more 
information about this window.

7. Choose OK to close the window after viewing the information.

Creating a report option

In order to print Kardex reports, you must first create a report option. You can 
include specifications for sorting options and range restrictions for a particular 
report. Each report can have several different options so that you can easily print 
the information you need.

To create a report option:
1. Open the Kardex History Options window.

(Reports >> Inventory >> Kardex >> New or Modify button)

2. In the Option field, enter the name of the report option that you are creating or 
select an existing one to modify. The Report field displays the name of the 
report for which you’re creating or modifying a report option. 
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3. Select whether the report option you are creating is for a detailed or a summary 
report.

4. In the Options group, select to print the report for all the sites or select a site.

5. In the Ranges field, select the criterion to filter the documents to print the 
report. The options are Item Number, Description, Class, Date, Type and Color.

6. Enter the range for the selected criterion in the From and To fields respectively.

7. Choose Insert to insert the range and then enter any additional ranges if 
necessary.

8. Highlight a range and choose Remove to remove a range from the Restrictions 
field.

9. Choose Destination to select a printing destination for the report option. You 
can print reports to the screen, to the printer or to a file, and you can indicate 
that you want to be asked to select a destination each time the report option is 
printed. 

10. Choose Save to save the report option you have created or modified.

11. Choose Delete to delete the report option that is displayed.

12. Choose Clear to clear the window.

13. Choose Print to print the Kardex History for the report option displayed in the 
window.

Printing Kardex reports

Use the Historical Kardex Reports window to print the detail or summary inventory 
Kardex reports for your company.

To print Kardex reports:
1. Open the Historical Kardex Reports window.

(Reports >> Inventory >> Kardex)

2. Select Kardex History in the Reports field.

The Options group displays the report options you have created for the selected 
report type.
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3. Select a report option and choose Insert to insert it in the Print List group. You 
can select multiple report options to print.

4. To remove a report option, highlight the report option in the Print List group 
and choose Remove.

5. Choose Clear to clear the report options displayed in the Print List.

6. Choose Print to print the report options in the Print List.
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